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MARKET AT A GLANCE VALUE STOCKS INVESTOR-ONE PORTFOLIO 23 INSIDER TRADES

m REGIONAL MARKETS C-SUITE: NAVIGATING COMPANY SPOTLIGHT: IR ANNOUNCEMENTS

LEADERSHIP SHIFTS, CHARTING AMIDST COAL MARKET
E DIVIDEND STOCKS GROWTH, AND DECODING THE DECLINE: WHAT DO YOU 25 INVESTMENT BOOKS
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at a Glance . A
) www.shareinvestor.com | market data at your fingertips &
Over 5 trading days as at yesterday z
)
tep-by-st 1. mouse over Ranking > select Top Active > mouse over Column Layout > select Column Layout > select Edit Customs > select Name > select Last Done Price > <
SHAREINVESTOR SIEP-DY-SIED Edit Customs > select Name > select Volume > select Last Done Price > Mouse select 5 Days Change > select 5 Days % Change > Mouse Over Column Layout >
WEBPR®@ GUIDE Over Column Layout > select Custom select Custom |<_t
2. mcl)use %ver Ranking > sellect Top TurnO\l/er > mouse over Columr|1 Layotft > 4. mouse over Ranking > select Top Losers (Over 5 Trading Days)
select Edit Customs > select Name > select Last Done Price > select Value > ; 9 ; ;
Sharelnvestor WebPro (www.shareinvestor.com) Mouse Over Column Layout > select Custom 2 mouse over Eantmg > se:ect ?p Of Ealners (()OverSSTTqu|ngDDays)
Prices > Stock Prices > SGX > click Stocks tab 3. mouse over Ranking > select Top Gainers (Over 5 Trading Days) > mouse over - VB ever Rendng > ssieet vop % Leses (Orer © ekl Days)
Singapore Top Actives Top Gainers Top Losers
(as at yesterday) (over 5 Trading days as at yesterday) (over 5 Trading days as at yesterday)
Name Last Done Volume Name Last Done 5 Days Chg Name Last Done 5 Days Chg
Seatrium 0.143 499,167.30 SPDR S&P500 US$ 451.520 9.83 NIO Inc. USD OV 10.410 -0.84
HSI 19600MBeCW230928 0.037 32,578.00 GLD SG$ 243.100 410 Nasdaq 7xLongSG241016 2.980 -0.78
Alset 0.034 20,575.60 GLD US$ 179.680 3.28 Baidu 5xShortSG240709 0.495 -0.47
HSI 19800MBeCW231129 0.098 20,500.00 JMH USD 47.480 2.00 Venture 12.980 -0.42
HSI 20200MBeCW231030 0.055 19,685.00 SPDR DJIA US$ 347.640 1.09 HSCEI3xShortMA260327US$ 2.050 -0.33
Rex Intl 0.143 18,483.10 NX18100A 280501 92.000 1.00 HSI3xShortMA260327US$ 2.220 -0.33
Singtel 2.360 17,033.10 Jardine C&C 32.990 0.89 Meituan 5xShortSG231220 0.635 -0.33
HSTECH 6000MBeCW240627 0.085 16,600.00 Haw Par 10.210 0.88 HSI 7xShortSG241218 0.795 -0.31
OUE Com Reit 0.240 16,041.70 YZJ 5xLongSG231115 3.130 0.76 Cortina 3.280 -0.27
HSI 19400MBeCW231030 0.086 15,852.00 XT MSCHINA S$ 19.030 0.73 LiNing 5xShortUB250321 1.300 -0.27
Singapore Top Turnover Top % Gainers Top % Losers
(as at yesterday) (over 5 Trading days as at yesterday) (over 5 Trading days as at yesterday)
Seatrium 0.143 72,116,634.00 Advanced 0.235 186.59 WuxiBio 5xShortSG240709 0.118 -65.29
Singtel 2.360 40,471,004.00 BYD MB eCW240103 0.033 120.00 ANTA 5xShortUB250430 0.010 -60.00
Venture 12.980 40,105,789.00 CapAllianz 0.002 100.00 Lenovo 5xShortSG240215 0.006 -60.00
DBS 33.120 34,656,037.00 WauxiBio 5xLongUB250930 0.059 90.32 HSI 16800MBePW230928 0.028 -56.25
Sembcorp Ind 5.490 30,444,509.00 HSI 22200MBeCW231030 0.026 85.71 WuxiBio 5xShortUB250321 0.144 -55.00
uoB 28.400 25,177,586.00 WuxiBio 5xLongSG231102 0.045 80.00 Alibaba 5xLongSG231214 0.001 -50.00
SIA 6.890 24,906,637.00 ANTA 5xLongSG240620 0.057 78.12 Baidu 5xShortSG240709 0.495 -48.70
Mapletree Ind Tr 2.310 24,094,826.00 Baidu 5xLongSG231115 0.365 78.05 BYD 5xShortSG230914 0.034 -47.69
CapLand Ascendas REIT 2.790 20,476,212.00 HKEx 5xLongUB250228 0.117 76.19 BYD 5xShortUB251031 0.040 -47.37
YZJ Shipbldg SGD 1.720 20,293856.00 BYD 5xLongSG250626 0.485 7321 BYD 5xShortUB250430 0.041 -46.75

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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Momentum
Trading & Gro _

Investing of Bullish Global Stocks

3 BONUSES FOR ATTENDEES:

«  Free investment eBooks x2

(Global Market Outlook & Dreamteam Portfolio) by Dr Tee
 Free stock diagnosis for early birds (Starts from 1pm)
- Free global stock screener following Dr Tee strategies
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Markets

Over 5 trading days

BURSA

O,

SHAREINVESTOR

WEBPR®

step-by-step

GUIDE

for weekly Inve$t

Sharelnvestor WebPro (www.shareinvestor.com)

. Price > Stock prices

. select Market: Bursa / HKEX / NYSE / NASDAQ (one bourse at a time)

. select Stocks Tab

. select Ranking Top Gainers or Top Losers (Over 5 Trading Days)

. Mouse over Column Layout > select Edit Customs > select Name > select Last Done Price > select 5 Days
Change > select 52 Weeks High > select 52 Weeks Low > Mouse Over Column Layout > select Custom

a b wnNn =

Top Gainers Top Losers
5 Days 52 Weeks 52 Weeks 5 Days 52 Weeks 52 Weeks
Name Last Done Change High e Name Last Done Change High e
MPI 28.800 1.940 34.980 23.600 HEXTECH 25.660 -2.520 30.600 3.680
AIRPORT 7.370 0.470 7.540 5.400 HEIM 23.800 -2.100 30.000 22.740
HAPSENG 4.000 0.460 7.400 3.030 KLK 21.540 -1.240 23.940 19.420
MBMR 4.150 0.460 4.500 3.010 NESTLE 130.500 -1.000 140.600 127.200
YTLPOWR-C24 1.150 0.370 1.150 0.090 BKAWAN 20.300 -0.720 23.780 19.800
Top Gainers Top Losers
5 Days 52 Weeks 52 Weeks 5 Days 52 Weeks 52 Weeks
Name Last Done Change High T Name Last Done Change High lory
BOSERA ASSET MGT (INTL) CO LTD USD MON- R
EY MARKET ETE HKD 7,899.350 33.750 7,881.400 7,811.050 STAR CM HOLDINGS LIMITED 28.550 29.350 132.000 28.650
SPDR GOLD TRUST GOLD SHARES NPV 1,409.000 27.000 1,498.000 1,181.000 ENN ENERGY HOLDINGS LTD 63.600 -16.350 127.200 61.100
XTRACKERS NIFTY 50 SWAP UCITS ETF 1C 1,784.500 25.500 1,825.500 1,543.000 YSBINC 51.650 -8.050 64.500 19.000
HONG KONG EXCHANGES & CLEARING 309.000 25.000 382.400 208.200 LEPU SCIENTECH MEDICAL TECHNOLOGY S 26.000 -6.150 43.000 23.400
BYD COMPANY LIMITED 244.800 24.000 280.600 161.700 ANGELALIGN TECHNOLOGY INC 55.000 -5.500 139.800 53.500
Top Gainers Top Losers
5 Days 52 Weeks 52 Weeks 5 Days 52 Weeks 52 Weeks
Name Last Done Change High e Name Last Done Change High o
BERKSHIRE HATHAWAY INC 543,592.560 6,442.630 556,117.000 393,012.250 DECKERS OUTDOOR CORP 527.870 -22.350 568.470 298.610
NVR INC 6,294.160 160.210 6,474.530 3,816.555 BURLINGTON STORES INC 157.230 -12.720 239.940 106.470
TEXAS PACIFIC LAND CORPORATION 1,933.920 57.610 2,739.000 1,266.210 AMC ENTERTAINMENT HOLDINGS INC 10.910 -8.690 107.500 10.720
BANK OF AMERICA CORPORATION 7.25% NON-
AUTOZONE INC 2,527.500 52.490 2,750.000 2,050.210 CUM PERP CONV PED SER L 1,140.050 -6.950 1,262.400 1,036.880
METTLER-TOLEDO INTERNATIONAL INC 1,206.830 41.740 1,615.970 1,065.550 FACTSET RESEARCH SYSTEMS 430.810 -6.740 474130 377.890
Top Gainers Top Losers
5 Days 52 Weeks 52 Weeks 5 Days 52 Weeks 52 Weeks
Name Last Done Change High Low Name Last Done Change High Low
MERCADOLIBRE INC 1,304.660 45.790 1,388.390 754.760 RUSH ENTERPRISES 45.080 -24.000 75.080 46.880
CHARTER COMMUNICATIONS INC 451.100 35.820 432.240 297.660 ULTA BEAUTY INC 415.110 -22.850 556.600 373.795
INTUIT INC 536.490 35.630 522.675 352.630 RUSH ENTERPRISES 41.240 -21.960 69.450 42.720
EQUINIX INC 790.590 30.400 821.630 494.890 SUPER MICRO COMPUTER INC 261.630 -15.980 357.000 50.280

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages

resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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SHAREINVESTOR

______________ WEBPR®@

SE=S T S STOCK MARKET DATA
~ _® AT YOURFINGERTIPS

=t Powerful browser-based market analytics platform.
B Access from anywhere

......

©
Portfolio
Management
© » Profit & Loss Summary
8 Markets Data > Stock Alert
P Get access to data from » News & Events filtering

Bursa, NYSE, Nasdagq,
HKEX, SGX, IDX, SET & ASX

@ Fundamental Analysis @

@ » Customizable column layout

Financial Analysis ® ® © FactSheet
@ Statement > Key Stock Information ()

» Profit & Loss T h . I B k y » Ownership

» Balance Sheet © ec n-lca © FOKErS » Consensus Estimates
Chartlng ca" » Annual Report

» Cash Flow Statement » C? chart (Customisable & ® o .

» More than 20 Financial Ratios Comprehensive) o » Historical Price

» Dividend Analysis gﬂrll‘ISIC Value » Insider Trades

alculator

What’s new on WebPro (stable Release 12.1.0)

In our effort to keep our platform at the forefront of trading technology, we have added on some
new features onto our C2 Chart in WebPro

ADDITIONAL NEW FEATURES:
Anchor selector for AVWAP, PVAT, and PAV indicators
Volume profile indicator by date range
Moving Average Cross indicator
Guppy Multiple Moving Average (GMMA) indicator
GoNoGo Trend Signal indicators
SignallQ

So what are you waiting for? Head to our platform today and check out our new trading chart
features and indicators. We're confident that you'll love the improvements we've made and that
they'll help you become a more successful trader.

Click here to start your 9 days FREE trial
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Dividend Stocks (as at yesterday)

DEFINITION Company is paying out dividend with low or moderate leverage.

for weekly InveSt

STOCKS

CHART GUIDE  Total Shareholder Return (TSR) combines share price appreciation and distributions paid to show the total return to the shareholder expressed as a percentage.

Sharelnvestor WebPro > Screener > Market Screener + Fundamental Analysis Conditions tab >select (v) Total Shareholder Returns 6. CAGR of Dividend Per Share - - select (less than) type (30)
SHAREINVESTOR (FA & TA) > select SGX > add criteria + Fundamental Analysis Conditions tab / >select (vi) CAGR of Dividend Per Share % for the past select (5) financial year(s)
WEBPR@ A. Criteria - Fundamental Analysis Conditions tab >select (vii) CAGR of Dividend Per Share 7. CAGR of Dividend Per Share - — select (more than) type (1)
step-by-step > click Add Criteria B. Conditions (Criteria Filters) % for the past select (5) financial year(s) -
+ Fundamental Analysis Conditions tab >select (i) 1. Dividend Yield - select (more than) type (1) % for the past select (1) financial year(s) > click Save Template > Create New Template type (Dividend
Dividend Yield 2. Dividend Payout (Historical) - select (between) type (0.5) to type (1) times for the Companies) > click Create o )
Fundamental Analysis Conditions tab >select (ii) past select (1) financial year(s) > click Save Template as > select Dividend Companies >
Dividend Payout (Historical) 3. Total Debt to Equity — select (less than) type (1) for the past select (1) financial click Save _
Fundamental Analysis Conditions tab >select (iii) year(s) > click Screen Now (may take a few minutes)
Total Debt To Equity 4. Total Shareholder Return - - select (more than) type (5) % for the past select (3) > Sort By: Select (Dividend Yield) Select (Desc)
Fundamental Analysis Conditions tab >select (iv) financial year(s) > Mouse over stock name > Factsheet > looking for Total
Total Shareholder Returns 5. Total Shareholder Return - — select (more than) type (5) % for the past select (5) Shareholder Return

financial year(s)

New Toyo
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MAKE BETTER TRADE}NG STRATEGIES
Wit

SHAREINVESTOR

STATION

©® 8 Markets Data © Dynamic Chart
» Get access to data from Bursa, NYSE, Nasdag, » Candlestick Pattern Recognition
HKEX, SGX, IDX, SET & ASX b 111 Indicators

» 39 Drawing Tools
» Performance Comparison Chart

© Intraday Data © Market Screener
» Market Depth 4 ?_2 cgteria rangirlwzgtfrorrl FA, @ Power Frame

» Trade Summary Matrix & Chart
» Times & Sales
> Intraday Market Ticker

© © O, © ©,
Technical Analysis

o Fundamental Analysis o

» Real-time Data » Combining few Dynamic
Charts together with intraday
information in one frame

©  Financial Analysis FactSheet ©
Statement b Key Stock Information
» Profit & Loss » Ownership
» Balance Sheet Start your 18 dayS T b Consensus Estimates
» Cash Flow Statement FREE tri a| now - i » Annual Report
» More than 20 Financial Ratios » Historical Pri
» Dividend Analysis (Valued at SGD$52 40) E {;; > In;;ercjradeze
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Fundamental Analys

Growth Stocks (as at yesterday)

DEFINITION Company revenue is growing and making good quality of earnings with positive Free Cash Flow.

for weekly InveS$t

STOCKS

CHART GUIDE  Total Shareholder Return (TSR) combines share price appreciation and distributions paid to show the total return to the shareholder expressed as a percentage.

Sharelnvestor WebPro > Screener > Market Screener B. Conditions (Criteria Filters) > click Save Template as > select Growth
SHAREINVESTOR (FA & TA) > select SGX > add criteria 1. Free Cash Flow - select (more than) type (1) for the past select (1) financial year(s) Companies > click Save
WEBPR@ A. Criteria 2. Revenue Growth - select (more than) type (1) for the past select (1) financial year(s) > click Screen Now (may take a few minutes)
step-by-step 1. Fundamental Analysis Conditions tab >select (i) 3. Gross Profit (Earnings) Margin - select (more than) type (30) % for the past select (1) > Sort By: Select (Revenue Growth) Select
Free Cash Flow, (ii) Revenue Growth, (iii) Gross financial year(s) _ (Desc)
G U I D E Profit (Earnings) Margin, (iv) Quality of Earnings 4. Quality of Earnings — select (more than) type (1) for the past select (1) financial year(s) > Mouse over stock name > Factsheet >
(v) Total Shareholder Returns 5. Total Shareholder Return - — select (more than) type (5) % for the past select (3) looking for Total Shareholder Return
> click Add Criteria financial year(s)
2. Fundamental Analysis Conditions tab >select 6. Total Shareholder Return - — select (more than) type (5) % for the past select (5)
(vi) Total Shareholder Returns financial year(s) , ,
> click Add Criteria > click Save Template > Create New Template type (Growth Companies) > click Create

/"‘{)I\"ﬂ Golden Energy
ATl SoxAUE)

Long Term Ratem

/I’Tﬁ\.f Grand Bank Yatchs Limited
:|| 1[]] (56X G50)

Long Termn Retam

/\/ﬁ\,o" MarcoPolo Marine

lalle i) | (SGX: 5LY)

Sarlel Wi Halun

Disclaimer: The in
resulting fre
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COMPANY ANALYSIS AT YOUR FINGERTIPS

Click the Analysis buttons to access the Factsheets of
any company featured on the Hot Stocks (TA),

Momentum-Up (TA), Up-Trending (TA), Dividend (FA),
Growth (FA) & Value (FA) Stocks pages.

Invest,with knowledge
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Fundamental Analysis

Va I ue Stoc kS (as at yesterday) for weekly InveS$t

DEFINITION Share price of a company trading at a lower price as compared to its fundamentals (FA) such as financial performance and dividend, allowing it to be attractive to value investors.

STOCKS

CHART GUIDE  Total Shareholder Return (TSR) combines share price appreciation and dividend distributions paid to show the total return to the shareholder expressed as a percentage.

Sharelnvestor WebPro > Screener > Market Screener (FA & TA) > select SGX B. Conditions > click Save Template > Create New Template type
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step-by-ste A erterla o 2. CAGR of Net Earnings - select (more than) type (10) % click Save
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» Fundamental Analys!s Cond!t!ons tab (i) Price Earnlngs Ratio ) 3. Net Debt To Equity — select (less than) type (1) for the > Mouse over stock name > Factsheet > looking for
+ Fundamental Analysis Conditions tab >select (i) CAGR of Net Earnings past select (1) financial year(s) Total Shareholder Return
Fundamental Analysis Conditions tab >select (iii) Net Debt To Equity 4. Return On Equity (ROE) - select (more than) type (10) % > Mouse over stock name > Charts > click C2 Charts tab
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£€ Navigating
Leadership Shifts,
Charting Growth,
and Decoding the
New Housing
Policy 3

Vincent Wong, Investor-One / Fri, Aug 25, 8:00 AM / Images Courtesy of August Consulting

Kelvin Fong )
PropNex's Deputy CEO

Ismail Gafoor (r)

PropNex's Executive
Chairman and CEO

continued on next page...
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mid the rapidly evolving real estate sector, marked by technological
advancements and regulatory upheavals, PropNex Limited recently
announced pivotal leadership changes during its Mid-Year Convention 2023.

In the wake of these announcements, we secured an exclusive interview
with the CEO, Mr. Ismail Gafoor. During our conversation, he delved deep into
the motivations behind this restructuring, the company's forward-looking
expansion plans, and even shared his perspective on the government's
significant adjustments to housing policy.

SHAREINVESTOR

Mr Kelvin Fong, who has been with ‘ ‘
PropNex since 2002, has transitioned In the past five years,

from Executive Director to Deputy we've grown our
Chief Executive Officer. Meanwhile, network of agents from
Mr. Eddie Lim, having a 12-year 6000 to over 12.000

history in the real estate realm, is
promoted from Senior Vice President
to the newly created position of

which gives us 40-
50% market share. Our

Chief Agency Officer. Also, five team aim now is to increase
leaders have been promoted to the number to 15,000
Agency Vice Presidents. agents within the next

W hr I's.
The company co-founder, Mr. Ismail, two 1o three years ,,

remains as Executive Chairman

and CEO. He underlined that these

changes signify a broader vision of adjusting to a dynamic market, praising
the management'’s vast real estate expertise and dedication. Gafoor
explained that these organizational changes aim to prepare for PropNex's
growth trajectory.

"In the past five years, we've grown our network of agents from 6000 to over
12,000, which gives us 40-50% market share. Our aim now is to increase the
number to 15,000 agents within the next two to three years,’ shared Ismail
Gafoor.

However, Gafoor was quick to clarify, "And It's not just about increasing the
number of agents; we want to further increase our market share, and the

continued on next page...
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15000 agents will effectively give us ]
50-60% of it.” ‘ ‘ With a larger market

share, we will be
In today's digital age, where data-driven amassing a vast
insights are crucial, Gafoor sees the amount of data.
increase in market share as more than .
just a testament to the company's With the help of our
success. "With a larger market share," he technology, the data
explained, "we will be amassing a vast could be used to refine
amount of data. With the help of our and enhance our

technology, the customer service. jJ i
data could
be used to

refine and enhance our customer service."

Ismail Gafoor,
Executive
Chairman and
CEO of PropNex

The advent of technology has ushered in
a plethora of digital platforms that have
influenced the way businesses operate,
including the real estate sector. However,
Gafoor believes that PropNex, with its
distinct value proposition, can co-exist
seamlessly in this digital paradigm.

"The technology might be evolving,
but the essence remains
consistent: value. Our proprietary
data, unlike publicly available
data, is timely and up-to-date.
With the help of technology,
the data equips us with a
better understanding of
our customers’ preferences,
demand-supply, pricing
fluctuations, and much more.
This in-depth insight enables
us to offer a better value
proposition to our customers.”

continued on next page...
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When asked about PropNex's potential overseas expansion, the CEO
acknowledged its importance and confirmed that they are making progress.
The company has already established a presence with over 1,000 agents in
both Malaysia and Indonesia, and it's noteworthy that PropNex is currently
among the top five agencies in Malaysia.

Furthermore, although overseas operations haven't significantly boosted their
earnings as of now, the CEO remains optimistic. He believes that leveraging
their technology and concept will, in time, solidify their standing and
profitability abroad.

On the other hand, we also got to tap into his expertise on the recent
significant changes in public housing policy. Backing the new housing policy,
the CEO said, "We support the government policy and think it is necessary for
Singapore. It will mitigate the 'lottery effect’ when such flats are later put on
the resale market”

"If we're not doing this” he voiced concerns over the potential creation of
“elite” residential areas. “We're going to create “elitism” in certain places
which will eventually create social tensions.”

When probed about the potential financial implications of the policy, the

CEO explained, "Public housing represents only about 20% of our business
portfolio. Additionally, the effects of this policy are only projected to manifest
a decade from now. Therefore, there's no immediate effect on our company.”

Regardless of the shifts in policy, he said that individuals consistently have
varied reasons for buying or selling, and it's this very dynamism that sustains
a vibrant market. As we neared the conclusion of our interview.

Read also:

* Interview with LHN Ltd Executive Chairman: Targets Aggressive Growth and
Higher Dividend Payout

* In Conversation with Nordic's Executive Chairman: Decoding a Decade of
Strategic Transformation and Growth



https://www.investor-one.com/editorial/23355-Interview-with-LHN-Ltd-Executive-Chairman-Targets-Aggressive-Growth-and-Higher-Dividend-Payout
https://www.investor-one.com/editorial/23355-Interview-with-LHN-Ltd-Executive-Chairman-Targets-Aggressive-Growth-and-Higher-Dividend-Payout
https://www.investor-one.com/editorial/23579-In-Conversation-with-Nordics-Executive-Chairman-Decoding-a-Decade-of-Strategic-Transformation-and-Growth
https://www.investor-one.com/editorial/23579-In-Conversation-with-Nordics-Executive-Chairman-Decoding-a-Decade-of-Strategic-Transformation-and-Growth
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Curated and managed by the Investor-One team under Sharelnvestor,
this free-to-access portfolio will feature local small and mid-cap companies
within Singapore Exchange’s Mainboard and Catalist.

Join us on the journey and watch as we manage a locally vested portfolio
with a fund of $100,000.

INVESTOR

“ Investor-One Portfolio
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Nscover Growing Companies

Investor-One Portfolio [0

of 553 billion and
below

Curated by Investor-One team, this portfolio features growing small and
mid cap companies within Singapore Exchange Catalist and Main Board. %

INVESTOR-ONE PORTFOLIO

The criteria for the companies are selected based on the following S

. . . . . . Net Debt/Equity Positive Free Cash
metrics, with further evaluation on qualitative factors like management : : Flow
team and growth prospects:

Portiollo Yiekd ve DA = Rt MDHG\HHISIPHIJ |

vaksn [l rerttote St manw [ Bt Botan 2275 Vo [l Fomttotis metier Ay | T Y

Portoto Yied ve (RASTAE ] o

vaisn [l Forto fen w41 W s B 2 i

Note: The Portfolio Return indicated in the chart does not include dividend income, as opposed to Total Return that is inclusive of Dividend Income.

continued on next page...
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Discover Growing Companies

Summary | 90-08-2023 | Onen Fositions

INVESTOR-ONE PORTFOLIO

Unrealized PIL 4 -4,323

P/L +
Name# P/L Div Cost Value

Geo Energy Res p i 1 -2,907 : -1, 10,013 7,108
(-28.03%)

Hock Lian Seng i . k) 600 - 5,800 5,200
{-10.34%)

HRnetGroup : : ; -500
(-3.25%)

Hyphens Pharma i . ;i =260 i d 14,750
(-1.67%)

JEP Hidgs i 3 . 485 (4.84%) 10,013 10,498

Kimily } J 2 ! -800
(-20.00%)

Nordic . i 250 (6.33%)

Summary (30-08-2023 )

Closed Positions

Realized Profit < -2,900
MNames Proceeds

HG Metal . . 3,400

InnoTek . 4 -2, = 4,800

Transaction (20-08-2023 )

Action Stock Exchange Rate Date4

Buy JEP Hidgs 7 N/& . ; 4 Jul 2023

o
&

m
oy

6868886888

m
=

m
5

m
=

HG Metal
InnoTek

Geo Energy Res
HRnetGroup
Kimly

HG Metal
InnoTek

Mordic

Hyphens Pharma
Hock Lian Seng

Deposit

13 Mar 2023

13 Mar 2023

13 Mar 2023

16 Feb 2022

16 Feb 2022

16 Feb 2022

16 Feb 2022

16 Feb 2022

16 Feb 2022

16 Feb 2022

15 Feb 2022

continued on next page...
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Dividend (30-08-2023 )

YTD

TRAILING 12 MONTHS

2022

SGD 4902.70

|

SGD 4902.70

SGD 2459.20

Stock

Ex-Date

Payable Date

Amt

Amt(SGD)

HRnetGroup

30 Aug 2023

11 Sep 2023

SGD 0.0187

0.0187

Geo Energy Res

28 Aug 2023

06 Sep 2023

SGD 0.0050

0.0050

Nordic

17 Aug 2023

04 Sep 2023

SGD 0.0100

0.0100

Hyphens Pharma

16 Aug 2023

31 Aug 2023

SGD 0.0360

0.0360

Kimly

27 Jun 2023

14 Jul 2023

SGD 0.0056

0.0056

Geo Energy Res

29 May 2023

08 Jun 2023

SGD 0.0050

0.0050

Hyphens Pharma

09 May 2023

24 May 2023

SGD 0.0111

0.0111

Geo Energy Res

08 May 2023

17 May 2023

SGD 0.0400

0.0400

Nordic

07 May 2023

17 May 2023

SGD 0.0091

0.0091

Hock Lian Seng

07 May 2022

19 May 2022

SGD 0.0100

0.0100

HRnetGroup

03 May 2022

12 May 2022

SGD 0.0187

0.0187

Kimly

26 Jan 2022

08 Feb 2022

SGD 0.0112

0.0112

HRnetGroup

28 Aug 2022

06 Sep 2022

SGD 0.0213

0.0213

Nordic

16 Aug 2022

02 Sep 2022

SGD 0.0116

0.0116

Kimly

29 Jun 2022

15 Jul 2022

SGD 0.0056

0.0056

Hyphens Pharma

11 May 2022

25 May 2022

SGD 0.0067

0.0067

InnoTek

10 May 2022

25 May 2022

SGD 0.0200

0.0200

Hock Lian Seng

08 May 2022

20 May 2022

SGD 0.0125

0.0125

HRnetGroup

08 May 2022

18 May 2022

SGD 0.0300

0.0300

Nordic

05 May 2022

17 May 2022

SGD 0.0015

0.0015

Nordic

05 May 2022

17 May 2022

SGD 0.0061

0.0061

HG Metal

05 May 2022

20 May 2022

SGD 0.0400

0.0400

INVESTOR-ONE PORTFOLIO

This portfolio is managed by Investor-One research team, under Sharelnvestor.

Disclaimer:

1. The Investor-One portfolio is aggregated for educational and illustration purposes only. It is curated based on fixed financial parameters as
indicated above. The investor-one team select their stocks solely base on the these fixed parameters. The featured companies are for information
only and does not constitute investment advice.

. The investor-one team is not licensed by any financial authority in Singapore. You should consult your Trading Representative or Financial
Advisors before making any financial decisions.

. Current Price, current value and gain/loss (%) under current portfolio are based on 10 minutes delayed data.
. Purchase Price and Exit Price are based on EOD price.

. The views and opinions expressed does not necessarily reflect those of Sharelnvestor Pte Ltd nor any related companies of Sharelnvestor Pte
Ltd.
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COMPANY SPOTLIGHT

Amidst Coal Market Decline: What
Do You Need to Know About Geo
Energy's TH23 Performance

Vincent Wong, Investor-One / Wed, Aug 23, 8:00 AM

-
L

SEF CNER -y BRAL!

Geo Energy, a component of the i-One Portfolio operating within the coal
sector, has revealed its financial data for the first half of 2023. In the face
of a tough market landscape, the company has shared its performance
metrics.

 Coal Price Dynamics: The average ICl4 coal price experienced a decline,
moving from USS86.06 in 2022 to USS70.46 in TH2023; resulting in lower
revenue and profit.

 Revenue: Geo Energy's TH2023 revenue stands at US$239.8 million, a
notable decline of 35% from the US$368.3 million registered in TH2022.

« Gross Profit: The gross profit for TH2023 experienced a significant drop
of 68%, amounting to US$48.0 million compared to USS151.5 million in
T1H2022.

continued on next page...
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* Production Costs: There was an uptick in the production cash costs,
which grew from US$39.63 per tonne in TH2022 to USS$50.07 per tonne
in TH2023. Reasons cited include higher stripping ratios and increased
royalty rates to the Indonesian government.

« Shareholder Returns: A second interim dividend of 0.5 SG cent per share
has been declared, culminating in a total dividend yield of 22.2% when
combined with previous distributions.

 Acquisition: On 26 July 2023, Geo Energy acquired a controlling stake
in a listed Indonesian coal mining group with >300 million tonnes of 2P
reserves. This not only ensures over 20 years of mining life but positions
the company to ramp up production potentially to 25 million tonnes
annually.

- Diversification: Geo Energy is assessing potential investments in non-
coal sectors, aiming to diversify its business portfolio.

The management stated that average coal prices will remain well above
their flve-year average. Coal, on a global scale, retains its status as a
significant energy contributor for power generation. While Western
countries are observing reduced demand, the appetite for coal in Asian
regions, especially China, might mitigate this decrease. China's recent
approval of 50 gigawatts of new coal power in TH2023 and its projected
coal power growth until 2030 imply sustained coal imports. Nevertheless,
there are constraints on the coal supply due to aging resources and the
wider adoption of net-zero initiatives.

In light of these figures, it becomes evident that Geo Energy faced
challenges in the first half of 2023, as seen in the reduction in revenue and
profit margins as the coal prices declined and the cost of production goes
up. However, the market most probably had already largely anticipated the
decline. Before the release of these results, the stock was trading at a very
cheap valuation, with the price-to-earnings (P/E) ratio hovering around 2,

continued on next page...

Read f
suc(t:a:artrirglz‘er's(:3 :n INVESTOR


https://rebrand.ly/investform
http://rebrand.ly/6bv0m3f

Invest FRIDAY AUGUST 31,2023
for weekly InveSt

continued... [Amidst Coal Market Decline: What Do You Need to Know About
Geo Energy's IH23 Performance]

indicating that much of the bad news had already been baked into the share
price.

Maintain the current position in Geo Energy and closely monitor its
diversification efforts and post-acquisition performance. Reassess the
investment in the next quarter or after any significant announcements
related to its diversification strategy or any further material decline in coal
prices.

Learn how to identify Hot Stocks using Technical Analysis (TA) and Fundamental Analysis (FA)
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A New

Sharelnvestor Mobile App

' SHAREINVESTOR

| Your Window to Global Investments

Charting | Market | Watchlist | News | Prices | Alerts
Time & Sales | Key Statistics | More

Now available on

GET IT ON # Download on the

;__-Lih_’ Google Play . App Store
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Data extracted from WebPro,
accurate as at yesterday

Effective Change Stock Name Buyer / Seller Name (Classification 2) Securi Acquired / (Disposed) Price Closing No. of Shares After Trade
Date (Notice Date) Types ['000] Price ['o00]

Direct Deemed Total Direct Deemed Total % Held ©
29 Aug 2023 SunMoonFood SONG XIAOJUN [Dir/CEO] S/U 610 610 0.020 1,556 125,000 126,556 14.010
(29 Aug 2023)
28 Aug 2023 Aztech Gbl Siew Yoke Ping [SSH] S/U 188,649 188,649 0.790 188,649 188,649 24.440
(29 Aug 2023)
29 Aug 2023 Daiwa Hse Log Tr Daiwa House Asset Management Asia Pte. Ltd. ('DHAMA") [Tm/Rp] S/U 550 550 0.603 0.580 729 550 1,279 0.184
(29 Aug 2023)
29 Aug 2023 Daiwa Hse Log Tr Daiwa House Asset Management Asia Pte. Ltd. ('DHAMA") [Tm/Rp] S/U -550 -550 0.603 0.580 729 729 0.105
(29 Aug 2023)
29 Aug 2023 Singtel Lee Theng Kiat [Dir/CEO] S/U,R/O/W 128 128 2.360 251 251 0.002
(29 Aug 2023)
28 Aug 2023 Memiontec Hldgs Tay Kiat Seng [Dir/CEO] S/U -23,684 -23,684 0.190 325177 79,370 404,547 61.224
(29 Aug 2023)
24 Aug 2023 ICP Ltd ANG KONG MENG [SSH] S/U -149,286 -149,286 0.007 26,068 26,068 0.782
(28 Aug 2023)
24 Aug 2023 ISDN Keith Hsiang-Wen Toh [Dir/CEQ] S/U 724 724 0.390 38,280 38,280 8.580
(28 Aug 2023)
24 Aug 2023 ISDN Teo Cher Koon [Dir/CEO] S/U 2,760 2,760 0.390 143,949 143,949 32.280
(28 Aug 2023)
24 Aug 2023 ISDN Thang Yee Chin [SSH] S/U 2,760 2,760 0.415 0.390 143,949 143,949 32.280
(28 Aug 2023)
24 Aug 2023 ISDN Assetraise Holdings Limited [SSH] S/U 2,760 2,760 0.415 0.390 143,949 143,949 32.280
(28 Aug 2023)
28 Aug 2023 LHN Logistics MILKYWAY INTERNATIONAL CHEMICAL SUPPLY CHAIN PTE LTD S/U 12 157114 0.225 157,114 157,114 93.700
(28 Aug 2023) [SSH
28 Aug 2023 SunMoonFood SONG XIAOJUN [Dir/CEO] S/U 946 946 0.021 946 125,000 125946 13.940
(28 Aug 2023)
28 Aug 2023 JEP Andy Luong [Dir/CEQ] S/U 3 3 0.340 7,300 313,523 320,823 77.680
(28 Aug 2023)
25 Aug 2023 JEP UMS Holdings Limited [SSH] S/U 4,185 4,185 0.335 313,523 313,523 75.910
(28 Aug 2023)
25 Aug 2023 Trek 2000 Intl* Tan Joon Yong, Wayne [Dir/CEO] S/U 59,490 59,490 0.043 61,861 1,839 63,700 20.350
(28 Aug 2023)
25 Aug 2023 Trek 2000 Intl* Tan Henry @ Henn Tan [SSH] S/U -100,937 4,195 -96,742 0.043 800 4,965 5,765 1.840
(28 Aug 2023)
28 Aug 2023 Civmec James Finbarr Fitzgerald [Dir/CEQ] R/O/W -714 <714 0.815
(28 Aug 2023)
28 Aug 2023 Civmec Patrick John Tallon [Dir/CEQ] R/O/W -714 -714 0.815
(28 Aug 2023)
28 Aug 2023 Civmec Kevin James Deery [Dir/CEQ] S/UR/O/W 595 595 0.815 1418 8,775 10,193 2.010
(28 Aug 2023)
25 Aug 2023 QAF Lin Kejian [Dir/CEO] S/U 500 500 0.815 2,584 277370 279,953 48.665
(28 Aug 2023)
25 Aug 2023 Kim Heng Tan Keng Siong Thomas [Dir/CEQ] S/U 200 200 0.083 800 283,347 284,147 40.280
(28 Aug 2023)
23 Aug 2023 IHH EMPLOYEES PROVIDENT FUND BOARD [SSH] S/U 3,000 3,000 1.740 919,526 919,526 10.441
(28 Aug 2023)
21 Aug 2023 MindChamps DU CATHERINE [Dir/CEO] S/U -70 -70 0.305 126,606 126,606 52.130
(26 Aug 2023)
24 Aug 2023 ST Group Food Chen Khai Voon [SSH] S/U 143 143 0.175 17,195 17,195 7.000
(25 Aug 2023)
25 Aug 2023 Wilmar Intl Kuok Khoon Hong [Dir/CEQ] S/U 877 877 3.550 2,995 833,497 836,492 13.400
(25 Aug 2023)
22 Aug 2023 Suntec Reit Tang Yigang @ Gordon Tang [SSH] S/U 45 45 1.180 231,500 231,500 8.001
(25 Aug 2023)
25 Aug 2023 PARAGONREIT PARAGON REIT MANAGEMENT PTE. LTD. (the "Manager") [Tm/Rp] S/U 1,382 1,382 0.895 141,456 141,456 4.995
(25 Aug 2023)
24 Aug 2023 Frencken DATO' GOOI SOON CHAI [Dir/CEO] S/U -10 -10 1.030 7417 93,663 101,080 23.670
(25 Aug 2023)
22 Aug 2023 IHH EMPLOYEES PROVIDENT FUND BOARD [SSH] S/U 34 34 1.760 916,526 916,526 10.407
(25 Aug 2023)

Access WebPro to view more insider trades °

Disclaimer: The information on this page is provided as a service to readers. It does not constitute financial advice and/or any investment recommendations. Past performance is not indicative of future results. We assume no liability for damages
resulting from or arising out of the use of such information. It would be best if you did your own research to make your personal investment decisions wisely or consult a licenced investment advisor.
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IR Anhouncements
- Prices Proposed Issue Of A 7-Year JPY3.5
- &» Billion Senior Unsecured Fixed Rate Notes Pursuant To

ParkwayLife REIT

S$500 Million Multicurrency Debt Issuance Programme.

Attractive pricing of 1.28% for the proposed issue of 7-year fixed rate notes. Use of
proceeds for pre-emptive refinancing of existing fixed rate notes due in February 2024.

Further extension of debt maturity profile to 2030.
http://plifereit.listedcompany.com/news.html/id/2455406

Receives Overwhelming Shareholder Support With
Applications For Rights Issue Exceeding Available Rights
Shares By 59.33%.

As at the close of the Rights Issue on 16 August 2023, valid acceptances and
valid excess applications received was 159.33% of the Rights Shares available for
subscription. Net proceeds to be used for general working capital requirement and
repayment of banking facilities. Funds raised will increase the Group'’s ability to seize
opportunities for business growth and expansion at the opportune time.

http://isoteam.listedcompany.com/news.html/id/2455374

Reports Full-Year 2023 Results.

ISOTEAM

Achievedrevenueandprofitgrowthdespitechallengingoperatingconditions,Manufacturing
and PCBA Services and Engineering Services business segments delivered double-digit
revenue growth. Recorded stable operating cash flow and maintained sturdy cash balance

of $32.8 million. Proposed final dividend of 1.0 cent per share.

http://avitech.listedcompany.com/news.html/id/2455477

Unveils New Leadership Masterplan To Reinforce
Market Relevance & Achieve Business Growth.

Enhanced management structure provides leadership continuity and establishes a
robust architecture to strengthen organisational nimbleness and market relevance
amid an ever-changing operating environment. Executive Director, Mr Kelvin Fong, a 21-
year PropNex veteran, becomes Deputy CEO, Mr Eddie Lim takes on a newly created
role of Chief Agency Officer. Five outstanding team leaders promoted to Agency Vice
Presidents. Mr Ismail Gafoor remains as Executive Chairman and CEO to provide
strategic leadership. Key focus areas to enhance the scale and efficiency of sales teams
and raise professionalism in the industry to a new level.

http://propnex.listedcompany.com/news.html/id/2455634

PropNex

Million For FY2023, Declares 0.9 Cent Final Dividend.

S Registers A Profit Before Tax Of S$9.9

Revenue increased by 12.4% to SS174.1 million largely due to the opening of new
outlets. Combining with the interim dividends of 0.90 cent per share, bringing the total
dividend to 1.8 cents per share. The Group will continue to grow its QSR segment.

http://res.listedcompany.com/news.html/id/2455658

Form Strategic Partnership With GUUD To Launch The

First Trade Finance & Supply Chain Assets Token On SDAX.

e,

GUUD Pte. Ltd. and Intraco Limited are pleased to announce their strategic partnership
to launch the first trade token on SDAX Exchange Pte. Ltd's multi-asset, private markets

INTRACO Limited

investment platform, which is regulated by the Monetary Authority of Singapore. The
TradeTok are issued to accredited investors on SDAX and the proceeds raised are deployed
to fund trade finance and supply chain assets.

http://intraco.listedcompany.com/news.html/id/2455707

ANNOUNCEMENTS


http://isoteam.listedcompany.com/news.html/id/2455374
http://plifereit.listedcompany.com/news.html/id/2455406
http://avitech.listedcompany.com/news.html/id/2455477
http://propnex.listedcompany.com/news.html/id/2455634
http://res.listedcompany.com/news.html/id/2455658
http://intraco.listedcompany.com/news.html/id/2455707
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